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LICENSE TERMS AND CONDITIONS

FasTrak SoftWorks, Inc.

Licensor is the owner of all rights, including the copyright, in and to that certain set of executable computer programs identified

in the Registration Form, including design and structure thereof (the "Software"), together with all manuals and other written or

printed technical material provided with the Software to explain its operation and to aid in its use (the "Documentation").

Licensee wishes to have the right to use the Software, and Licensor is willing to grant such a right to Licensee on the terms and

conditions set forth herein.

1. GRANT OF LICENSE. In consideration of Licensee's payment of the license fee referred to below and Licensee's agreement

to abide by the terms and conditions stated herein, FasTrak SoftWorks, Inc. (referred to as "Licensor") grants Licensee a

nonexclusive right to use and display one (1) copy of the Software with respect to one microcomputer at a time for so long as

Licensee complies with the terms hereof. Licensor retains the right to terminate this Agreement and Licensee's rights at any time,

by written notice to Licensee, in the event Licensee violates any of the provisions hereof.

Licensor reserves all rights in and to the Software and Documentation not expressly granted to Licensee herein. Licensee agrees

to pay Licensor the license fee specified by Licensor as of the date hereof, payable in full upon deliver of a copy of the

Software and Documentation to Licensee. Licensee acknowledges that the license fee payable hereunder is consideration solely

for the right to use the Software, and payment thereof will not entitle Licensee to support, assistance, training, maintenance or

other services, or the enhancements or modifications to the Software which may subsequently be developed by Licensor, except

as otherwise expressly provided in this Agreement.

2. LICENSEE'S AGREEMENTS. Licensee agrees to comply with the terms and conditions set forth in this Agreement,

specifically including but not limited to the following:

a. Licensee will take all reasonable steps to protect the Software from theft or use contrary to the terms of this

Agreement.

b. Licensee agrees to pay Licensor additional license fees as specified by Licensor if and to the extent Licensee intends

to use or does use the Software in any way beyond the scope of this Agreement.

c. Licensee agrees not to modify the Software and not to disassemble, decompile, or otherwise reverse engineer of the

Software.

d. Licensee agrees to either destroy or return the original and all existing copies of the Software to Licensor within

five (5) days after receiving notice of Licensor's termination of this Agreement.

e. Licensee agrees not to disclose the Software or Documentation or any part thereof or any information relating

thereto to any other party, it being understood that the same contains and/or represents confidential information

which is proprietary to Licensor.

3. OWNERSHIP OF SOFTWARE. Licensee shall be deemed to own only the magnetic or other physical media on which the

copy of the Software provided to Licensee is originally or subsequently recorded or fixed, as well as any boards, key-locks, or

cables provided for use with the Software, but an express condition of this Agreement is that Licensor shall at all times retain

ownership of the Software recorded on the original diskette copy and all subsequent copies of the Software, regardless of the

form or media in or on which the original or other copies may initially or subsequently exist. This Agreement does not

constitute a sale of any copy of the Software to Licensee.

4. POSSESSION AND COPYING. Licensee agrees that the Software will only be displayed or read into or used on one (1)

computer at a time, at the location designated for notices to Licensee under paragraph 13, below. Licensee may change the

computer on which Licensee uses the Software to another computer at such location. Licensee agrees not to make copies of the

Software other than for its own use, all of which copies shall be kept in the possession or direct control of Licensee. Licensee

agrees to place a label on the outside of all copies showing the program name, version number, if applicable, and Licensor's

copyright and trademark notices in the same form as they appear on the original licensed copy

5. TRANSFER OR REPRODUCTION. Licensee is not licensed to copy, rent, lease, transfer, network, reproduce, display or

otherwise distribute the Software except as specifically provided in this Agreement. Licensee understands that unauthorized

reproduction of copies of the Software and/or unauthorized transfer of any copy of the Software is a violation of law and will

subject Licensee to suit for damages, injunctive relief and attorney's fees. Licensee further understands that it is responsible for

the acts of its agents and employees. Licensee may not transfer any copy of the Software to another person or entity, on either a

permanent or temporary basis, unless Licensee obtains the prior written approval of Licensor which will ordinarily be subject to

payment of Licensor's then current license transfer fee. Such approval will not unreasonably be withheld if Licensee advises

Licensor in writing of the name and address of the proposed transferee, such transferee is suitable in Licensor's sole judgement,

and such transferee agrees in writing to be bound by the terms and conditions of this Agreement. If the transfer is approved,

Licensee must deliver all copies of the Software, including the original copy to the transferee.



6. ENHANCEMENTS AND UPDATES. Licensor may from time to time release updates of the Software incorporating changes

intended to improve the operation and/or reliability of the Software. Such updates will be provided to Licensee at no charge

(except shipping charges and media costs) for a period of twelve (12) months from the date hereof, and Licensee agrees to install

all updates designated by Licensor as mandatory. Licensor may also offer enhanced versions of the Software from time to time

incorporating changes intended to provide new or enhanced features and/or capabilities, at such license fees as Licensor may

from time to time establish.

7. LIMITED WARRANTY AND DISCLAIMER OF LIABILITY. LICENSOR HAS NO CONTROLOVER THE

CONDITIONS UNDER WHICH LICENSEE USES THE SOFTWARE. THEREFORE, LICENSOR CANNOT AND DOES

NOT WARRANT THE PERFORMANCEOR RESULTS THAT MAY BE OBTAINED BY ITS USE. HOWEVER,

LICENSOR PROVIDES THE FOLLOWING LIMITED WARRANTY:

Licensor warrants, for a period of twelve (12) months only, that the Software shall be free from significant programming errors.

Licensor further warrants that it has full power and authority to grant the rights granted by this Agreement with respect to the

Software and that the use by Licensee of the Software and Documentation will not infringe the rights of others. In the event

Licensee believes that it has discovered one or more significant programming errors, Licensee shall immediately notify Licensor

of such fact in writing. If such notice is received by Licensor within twelve (12) months from the date hereof, Licensor shall,

within a reasonable time, subject to the demands of Licensor's other customers and subject to delays beyond Licensor's control

(including but not limited to labor trouble, illness, delays in shipment of materials, and bad weather), at Licensor's expense,

correct the programming errors. In the event Licensor is unable to correct the programming error within a reasonable time,

Licensee may elect to terminate this Agreement and receive a refund of the licensee fee paid hereunder. For purposes hereof, a

programming error is "significant" only if, as a result thereof, the software does not substantially perform the functions

described in the Documentation. Licensor does not warrant that the operation of the Software will be uninterrupted or error

free. EXCEPT FOR THE ABOVE EXPRESS WARRANTY, LICENSOR MAKES AND LICENSEE RECEIVES NO

WARRANTIES, EXPRESS, IMPLIED, STATUTORYOR OTHERWISE, AND LICENSOR SPECIFICALLY DISCLAIMS ANY

IMPLIED WARRANTY OFMERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

THE REMEDY PROVIDED HEREIN IS EXCLUSIVE. UNDER NO CIRCUMSTANCESWILL LICENSOR BE

RESPONSIBLE FOR DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL OR OTHER DAMAGES OR LOST

PROFITS. LICENSEE ACKNOWLEDGES THAT THE LICENSE FEE HEREUNDER IS NOT ADEQUATE FOR

LICENSOR TO ASSUMEOBLIGATIONS TO LICENSEE GREATER THAN THE EXPRESS REMEDY PROVIDED

ABOVE.

8. GOVERNING LAW. The validity and performance of this Agreement shall be governed by Wisconsin law, except as to

copyright and trademark matters which are governed by United States laws and international treaties. This Agreement is deemed

entered into in Wisconsin. All lawsuits arising out of this Agreement shall be brought in a court of general jurisdiction in

Milwaukee, Wisconsin. Licensor shall be entitled to recover its costs and expenses (including attorney's fees) incurred in

enforcing its rights under this Agreement.

9. WAIVER. The failure of Licensor to enforce any of the provisions hereof shall not be construed to be a waiver of the right to

enforce such provisions at a later time or to enforce any of the other provisions hereof.

10. EFFECT OF TERMINATION. The expiration or termination of this Agreement shall not affect the obligations of Licensee

which by their character are of continuing nature.

11. INTEGRATION. This Agreement sets forth the entire understanding and agreement of the parties shall be bound by any

conditions, definitions, warranties or representations with respect to any of the terms or conditions hereof other than as

expressly provided in this Agreement. This Agreement may only be modified by a writing signed by the party to be charged.

12. BINDING EFFECT. This Agreement shall be binding upon and shall inure to the benefit of the parties hereto and their

respective successors and assigns, subject to the limitations on the transfer of Licensee's rights to the Software provided in

paragraph 5, above.

13. NOTICES. All notices shall be in writing and shall be hand delivered or sent by U.S. mail, first class, postage prepaid, if to

Licensor at its address first above written, and to Licensee at the address indicated in the Registration Form. A party may change

its address for notices at any time by notice to the other party in the manner provided herein, but each party may have only one

address for notices at a time.

14. REGISTRATION FORM. The Registration Form is a part of this Agreement and is incorporated herein by reference. This

Agreement will not take effect, and Licensee will have no rights whatsoever with respect of the Software, unless and until the

Registration Form is duly executed and returned to the Licensor and is accepted by Licensor.
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Chapter 1 – System Requirements

and Installation

Using the Quick Start Guide

Welcome to the Quick Start Guide for the PLC WorkShop Suite/SuperSuite for Siemens

505. The purpose of this Quick Start Guide is to get you using the software quickly. For

this reason, this guide does not contain comprehensive information about all facets of the

Suite/SuperSuite. For detailed descriptions of features, please refer to the online help in-

cluded with each application.

PLC Workshop for Siemens 505 Suite/SuperSuite

Specifications

PLC Support

Supports the entire line of CTI 2500 Series PLCs: 2500-C100, C200, C300, C400

Supports the entire line of Siemens/TI 505 PLCs including:
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500 Series: 520 1101; 520C 1101, 1102; 530 1102, 1104, 1108; 530C/T 1104, 1108,

1112; 560 2120; 565 2120; 560T 2820; 565T 2820

505 Series: 525 1102, 1104, 1208; 535 1204, 1212; 545 1101-1106; 555 1101-1106; 575

2102-2106

Operating Systems

Client/Workstations

Windows XP Professional w/SP1 or later

Windows Vista Business or Enterprise

Windows 7 32-Bit or 64-Bit

Windows 8

Database Operating Systems

Windows Server 2003 SP1 or later

Windows Server 2008

Windows XP Professional SP1A or later

Windows Vista Business or Enterprise

Windows 7 32-Bit or 64-Bit

Windows 8

Note: Home/consumer versions of Windows are not supported.

Supported Databases

MS SQL Server 2005

MS SQL Server 2005 Express (included)

MS SQL Server 2008

MS SQL Server 2008 Express
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Communications Support

Supports all methods of communications including Serial with modem support (COM 1–

COM 256), TCP/IP, FMS, and Serial TIWAY

Hardware Requirements

PC Platform

Recommended – 1 GHz or greater

Memory

Recommended – 512 MB or greater

Hard Disk Space Required

100 MB for client, 525 MB minimum for database

NOTE: You must be logged in as the administrator to install the

PLC WorkShop for Siemens 505 Suite/SuperSuite.

Installing the PLC WorkShop for Siemens 505

Suite/SuperSuite

Installing the PLC WorkShop for Siemens 505 Suite/Super Suite consists of installing 505

WorkShop, 505 Simulator, and FTVersionTrak. The Suite includes the basic version of

FTVersionTrak (PE), while the SuperSuite include the full version. Contact Sales if you

want to upgrade.

Installing 505 WorkShop and 505 Simulator

1. Insert the PLC WorkShop for Siemens 505 CD in your PC's CD-ROM drive. You

must be an Administrator to install 505 WorkShop and 505 Simulator.

2. The setup program should start automatically. If not, manually run the setup pro-

gram. (The set up program can be found at x:\setup.exe, where x is the letter of the

CD-ROM drive).
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3. To install 505 WorkShop, click INSTALL 505 WORKSHOP and follow the in-

structions that appear.

4. To install 505 Simulator, click INSTALL 505 SIMULATOR and follow the in-

structions that appear.

5. When the installations are completed, click EXIT.

6. Remove the PLC WorkShop for Siemens 505 CD from your PC.

Installing FTVersionTrak

Please refer to the FTVersionTrak installation guide.
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Using FTVersionTrak with 505 WorkShop

This guide describes using the basic version (FTVersionTrak PE), as well as the complete

version (FTVersionTrak). The Suite includes FTVersionTrak PE, while the SuperSuite in-

cludes FTVersionTrak. Contact Sales if you would like to upgrade.

After installing FTVersionTrak, do the following to create a repository and begin ex-

periencing the benefits of using FTVersionTrak to track, manage, and compare changes to

your 505 WorkShop program files.

To create your FTVersionTrak repository:

1. Start your 505 WorkShop application.

2. At the top of the 505 WorkShop window, you should see the following FTVer-

sionTrak toolbar:

3. Click the button on the toolbar to start the FTVersionTrak client. The fol-

lowing dialog box appears. (Note: Users of the PLC WorkShop for Siemens 505
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SuperSuite will need to select a server first. See the online help for detailed in-

formation.)

4. Enter a name for your FTVersionTrak repository and click OK to create the re-

pository. Once the repository is created, you may close the FTVersionTrak client.

Certain aspects of the 505 WorkShop environment are different when your 505 WorkShop

programs are protected by FTVersionTrak. Most differences occur automatically when

opening and closing 505 WorkShop files. All other version control features can be ac-

cessed using the FTVersionTrak toolbar.

FTVersionTrak Toolbar

The FTVersionTrak toolbar consists of buttons that represent version control options avail-

able in 505 WorkShop. View the FTVersionTrak toolbar by clicking FTVersionTrak

Toolbar on the Toolbars menu.

Button Function

Connect to the FTVersionTrak repository and add the active program

Get a version of the active program file and place it into your working dir-

ectory

Check out the active program

Check in the active program

Undo checkout of the active program

Compare the working copy of the active program to the version in the re-

pository
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View the version history of the active program

Electronically sign the active program

Launch the FTVersionTrak client application

Adding Files to the FTVersionTrak Repository

Before FTVersionTrak can begin securing your program files, they must be added to the

FTVersionTrak repository. The repository is a secure, compressed database that exists

apart from you local file system. This database keeps track of any changes made to the files

added to it, as well as securing them from accidental or unauthorized deletion or removal.

To add a 505 WorkShop file to the FTVersionTrak repository:

1. Open the program file in 505 WorkShop.

2. Click on the FTVersionTrak toolbar. The Bind File to Repository dialog box ap-

pears.

3. Under Location, click Browse. The Select Repository Folder dialog box appears.
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4. By default, no repository folders have been created. Click OK to add your program

file to the root of the repository (this can always be changed later). Click OK to re-

turn to the Add File to Repository dialog box.

5. Click OK in the Add File to Repository dialog box. The program is added to the re-

pository, and FTVersionTrak will begin to manage the changes to your program.

Opening 505 WorkShop Files

Once a 505 WorkShop file has been added to the FTVersionTrak repository and the latest

version placed in your working directory, FTVersionTrak's seamless integration automates

the version control process. Follow this procedure when opening 505 WorkShop files pro-

tected by FTVersionTrak for best results:

1. After launching 505 WorkShop, open the program by clicking Open on the File

menu or by clicking the toolbar button. The Open Program dialog box appears.
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2. Click Browse and browse for the file. The file should be located in the directory

specified in the get operation. Select the file and click Open. Click OK in the Open

Program dialog box.

3. FTVersionTrak compares your version of the program with the version stored in the

repository. If a newer version of the program is available, a message appears, al-

lowing you to get the latest version.

l Click Yes to get the latest version.

l Click No to open the older version of the program.

4. FTVersionTrak then verifies the check out status of the file. If the file is checked

out to you, it opens normally. If not, a message appears, allowing you to check out

the file.
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l Click Yes to check out the file.

l Click No to open the file without checking it out.

l The program opens in 505 WorkShop.

5. After the program opens, the FTVersionTrak toolbar becomes active. The actions

available using the FTVersionTrak toolbar pertain to the active program.

Saving 505 WorkShop Files

Edits to 505 WorkShop files protected by FTVersionTrak are not complete until they have

been saved and checked in. 505 WorkShop automates this process to prevent accidental

loss of changes to the program. The processes below illustrate the various scenarios a user

encounters when attempting to save a 505 WorkShop file protected by FTVersionTrak.

Saving a 505 WorkShop File That Has Not Been Checked Out

If you attempt to save a file that is tracked by FTVersionTrak, but not checked out, then

you will be prompted to check out the file.

Clicking Yes displays the Check Out dialog box. After the file is checked out, 505

WorkShop saves the file.
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NOTE: Depending on the FTVersionTrak Options set in 505

WorkShop, available by clicking Application Setup on

the Options menu, you may be prompted to check in the

file after it has been saved. Otherwise, you can check in

the file by clicking in the FTVersionTrak toolbar.

If you click No, the Save As dialog box appears. If the file is not checked out, you must

save the file with a different filename to keep any changes made to the file.

Saving a 505 WorkShop File that is Currently Checked Out

When you choose to save a program that is checked out to you, 505 WorkShop can also

check in the file for you automatically. Clicking Application Setup on the Options menu

in 505 WorkShop displays the FTVersionTrak Options available in 505 WorkShop. Select-

ing the Ask to Check In File After Save check box displays the following message after

each save:

Clicking Yes displays the Check In dialog box. After the file is checked in, 505 WorkShop

keeps the file checked out to you so that you may continue editing the program. Clicking

No saves the working copy on your computer but does not write any changes to the

FTVersionTrak repository. The file can be checked in manually by clicking on the

FTVersionTrak toolbar.

Closing 505 WorkShop Files

The procedure to close a 505 WorkShop file is slightly different when the file is protected

by FTVersionTrak. Depending on the file's status, FTVersionTrak offers a number of dif-

ferent options to the user to prevent the loss of data.
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Closing Programs that are Checked Out

If the program file being closed is checked out to the current user, FTVersionTrak displays

a prompt suggesting the file be checked in.

Click Yes to display the Check In dialog box. After the file is checked in, the file closes

normally. Click No to close the file, leaving it checked out.

NOTE: If the file contains edits that have not been saved, 505

WorkShop will prompt the user to save the file before

continuing.

Closing Programs that are Checked In

If a program file being closed has been checked in and no edits remain pending, the file

closes normally. However, if the file being closed is checked in (or has not yet been

checked out) and edits have been made to the program that have not yet been saved, 505

WorkShop will not immediately close the program.

505 WorkShop first prompts the user to save the file.

l Click No to lose any unsaved changes and close the program.

l Click Cancel to cancel the save and keep the program open.
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l Click Yes to save the file. 505 WorkShop then prompts the user to check out the

file.

l Click No to display the Save As dialog box and save the file to another file name.

l Click Yes to display the Check Out dialog box.

l Once the file has been checked out, 505 Workshop prompts the user to check the

file back in to the repository.

l Click No to close the program without writing any changes to the repository. The

file is still checked out to the user.

l Click Yes to write changes to the repository and close the program.

Getting Versions of a File

The Get action retrieves a version of the active program from the repository and places it

in your working directory as a read-only copy to review or check out.

To get a version of the active 505 WorkShop program:

1. Click on the FTVersionTrak toolbar. The Get dialog box appears.
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2. Select the options of the version you would like to get under Version:

l Selecting Latest Version places the latest version of the file into your working dir-

ectory.

l Selecting Version allows you to choose the version you would like to get.

l Selecting Latest Version of State allows you to choose a version with a particular

repository file state.

l Selecting Labeled Version allows you to choose a version with a particular label.

3. In the To box, enter the directory in which to place the working copy or click

Browse to locate the desired directory. If a working directory has been set, it ap-

pears in the text box. If a working directory has not been set, the text box appears as

blank.

4. Select the Overwrite working copies checkbox to automatically overwrite any files

located within the directory assigned in the To box with the Get target files of the

same name.

5. Select theMake Writable check box to remove the read-only status from the pro-

gram file.
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NOTE: Making working copies writable is not recommended for

files you wish to keep under version control. Do not se-

lect this option if you plan on checking out and editing

the file.

6. Click OK when finished. A version of the file is placed in the selected directory.

NOTE: If the path selected in the To box is the same as the path

of the active program file, the active file will be over-

written even if the Overwrite working copies check box

is not selected. If you proceed to overwrite the active

program file, the program will exit and any existing

changes will be lost. You must open the program again to

continue.

Checking Out Files

To make changes to your 505 WorkShop program using FTVersionTrak, it must first be

checked out. Checking out a file places a writable copy of the file within the user's working

directory. If the file is already present in the working directory (following a Get action, for

example) then FTVersionTrak removes the read-only status on the file while it is checked

out.

1. Click on the FTVersionTrak toolbar. The Check Out dialog box appears.

2. In the To box, enter the directory in which to place the working copy or click

Browse to browse for the directory. If a working directory has been set, it appears
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in the text box. If a working directory has not been set, the text box appears as

blank.

3. Select the Do not get local copy check box if you do not wish to get the version

of the repository file while checking the file out.

NOTE: Using the Do not get local copy option only checks out

the file. This is helpful if your working copy is different

than the latest version within FTVersionTrak.

4. If you want, enter a comment about the check out within the Comment box. This

comment may be edited when the file or folder is checked in. Click OK when fin-

ished.

After checking out a file or folder, the following options are available:

l Check In the file or folder to write any edits to FTVersionTrak and create a new

version.

l Undo the Check Out to cancel any changes made to the file or folder.

Checking In Files

Check in the program file to write changes to the master copy located in the FTVer-

sionTrak repository. After you check the file in, other users will be able to Get the

modified file, view the changes you have made to the file, and check out the file to work

on it as well.

To check in the active 505 WorkShop file:

1. Click on the FTVersionTrak toolbar. The Check In dialog box appears.
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2. In the Comment box, type a comment for the check in (optional). If a comment

was entered during checkout, it will appear by default in the text box. Select the

Use Checkout Comment check box to use this comment.

3. The From: box will display the local path that the new version will be written from

(usually the working directory). Click Browse to browse to a different directory.

4. Select the Keep checked out check box to write any changes to the repository but

keep the program checked out to you.

5. Select the Delete local copy check box to remove the working copy on your local

system after the check in.

6. Click Compare to compare the differences between the version being checked in

and another version in the repository.

7. Click OK when finished to check in the items.

Undoing a Check Out

Undo the check out if you decide not to save any changes to the repository or create a new

version of the 505 WorkShop program. Undoing a checkout leaves the file in the state it

was in before you checked it out. No new version is created, and no record of the check-

out will be left.

To undo a check out of the active 505 WorkShop program:

1. Click in the FTVersionTrak toolbar. The Undo Check Out dialog box appears.
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2. Select a Local Copy option:

l Select Replace to replace the local copy of the checked out file with the latest

version within the repository.

l Select Leave to leave the existing copy of the checked out file on your local system.

l Select Delete to delete the local copy from the checkout location. If the file was

checked out to a location other than the working directory, the location indicated

at check out will be deleted and any other copies will be retained.

3. Click OK when finished to return to the main window.

Comparing 505 WorkShop Files

One of the most useful features of FTVersionTrak is the ability to compare the contents of

two 505 WorkShop files to each other. Within 505 WorkShop, you may compare two dif-

ferent versions of the same 505 WorkShop program to each other, or compare a version in

the FTVersionTrak repository to the working copy on your local hard drive.

To compare the working copy of the active 505 WorkShop program to the latest version in

the repository:

1. Click the button on the FTVersionTrak toolbar. The Compare Files dialog box

appears.
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2. Click OK to view the file compare results. See the FTVersionTrak documentation

for more information on file compare results.

To compare the difference between two version of the active 505 WorkShop program:

1. Click on the FTVersionTrak toolbar. The History dialog box appears.

2. Select the first version of the file you would like to compare. Hold down the CTRL

key and select the second version of the file you would like to compare. Click Com-

pare. The Compare Files dialog box appears.
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n The check box options apply only to text file comparison and can be ignored

when comparing 505 WorkShop files.

3. Click OK to view the file compare results. See the FTVersionTrak documentation

for more information on file compare results.

NOTE: Clicking Compare without selecting more than one ver-

sion will compare the selected version to the working

copy. Clicking Compare without selecting any version

will compare the latest version to the working copy.

Viewing File History

Each 505 WorkShop file that is managed by FTVersionTrak is given its own history. As

you check out, edit, and check in your programs, the history is updated to reflect these

changes. Viewing history is the best way to get a clear picture of the changes a program has

gone through.

To view the active 505 WorkShop program's version history:

1. Click in the FTVersionTrak toolbar. The History dialog box appears.
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2. The History dialog box displays all the version information of the selected file. Each

version displayed in the History dialog box contains the following information:

l Version - The version number of the listed version.

l Username - The name of the user that created the listed version.

l Date - The date and time the listed version was added to the repository.

l State - The version state of the file when it was added to the repository.

l Comment - The contents of the optional comment created when the file was

checked in.

3. The following two optional version histories may be viewed by selecting the ap-

propriate check boxes at the bottom of the History dialog box:

l Show Labels - Select this option to display any associated labels with the re-

pository file. Each label will appear as a separate version of the file, with the tag

Label substituted for the version number.

l Show Electronic Signatures - Select this option to display any associated elec-

tronic signatures with the repository file. Each signature will appear as a separate

version of the file, with the tag Signature substituted for the version number.

4. The buttons on the right side of the History dialog box are used to manage a file's

history:

l Close - Closes the History dialog box and returns to the main window.
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l Compare - Selecting a version and clicking Compare will compare the selected

version with the copy in the user's working directory. Selecting two versions and

clicking Compare will compare the two versions to each other.

l View - Launches the application associated with the selected version, and opens

the version of the file within the application as a read-only document.

l Get - Retrieves the selected version of the file to the user's local working directory.

l Report - Generates a history report of the selected repository file.

l Rollback - Reverts the most recent version of the repository file to the selected

version. Rollback is only available if the file has more than one version, and can

only be selected when a version other than the latest version is selected.

l Sign - Electronically signs the selected version of the file, and allows the option

to change the version state.

l Properties - View the properties of the selected version, and allow the option to

change the version comment.

Electronically Signing 505 WorkShop Files

Electronic signatures can be used as an approval method to verify that a certain user has

seen a selected version of a repository file, and can also be used to advance the version

state of the repository file. FTVersionTrak's electronic signatures conform with portions of

FDA 21 CFR Part 11 regulations.

To electronically sign the active 505 WorkShop program:

1. Click on the FTVersionTrak toolbar. The Sign Document dialog box appears.
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2. The File and Username boxes are filled with the selected file and current user, re-

spectively. Type the current user's password in the Password box.

3. Select the current version state of the file from the State box and type any com-

ments in the Comment box (optional).

4. Click OK when finished to return to the main window.
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Setting Up Communications

Pre-configure serial ports, a modem board, or network interface boards in the PC for use

with a SIMATIC 505 PLC. To configure communications:

1. Click Communications Setup from the File menu. The Communications Setup

dialog box appears.
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2. Select the appropriate PLC communications to be set up.

Fast PLC Connection Setup

Prior to connecting using Fast PLC Connection for the first time, the PLC connection

must be set up.

1. Click Fast PLC Setupfrom the File menu. The Fast PLC Connection dialog box,

which is identical to the Communications Setup dialog box, appears.

2. Select the appropriate communication port to configure and select the serial port or

board for communication with the PLC.

Online/Offline

Programs can be opened and edited within a file (offline) or in the PLC (online).

In Offline mode, logic, data, configuration, and documentation is edited in the *.FSS file

without involving the PLC in any way.

In Online mode, the program is edited in the PLC. Logic, data, and configuration are read

from the PLC memory, and the associated documentation is read from the *.FSS file,

which is the file name extension used by 505 WorkShop.

Editing or modifying a program online

may produce unexpected or hazardous res-

ults.

505 WorkShop offers the following options for working with programs online:

Using Fast PLC

Connect

Logic, data, and configuration are read from the

PLC memory. Documentation will not be as-

sociated with the program.

Connecting On-

line with a

Program File

Logic, data, and configuration are read from the

PLC memory, and associated documentation

from the *.FSS file.
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Loading a File to

the PLC

Logic, data, and configuration from the *.FSS

file are downloaded to the PLC, and associated

documentation is read from the *.FSS file.

Transferring an

Offline Program

Online

Logic, data, and configuration from a *.FSS file

that has already been opened are transferred to

the PLC, and associated documentation is read

from the *.FSS file.

Loading Parts of a

File Online

Individual program components from the *.FSS

file are transferred to the PLC, and associated

documentation is read from the *.FSS file.

Saving a Program

from the PLC to

Disk

Logic, data, and configuration from the PLC are

uploaded to the *.FSS file and saved with any ex-

isting documentation.

505 WorkShop allows both online and offline programs to be open at the same time. All

programs are opened / loaded from the Open dialog.

Creating a New Program

New programs are created in offline mode only. To create a new logic program and begin

programming:

1. Click New from the Filemenu, click the  toolbar button, or press [CTRL+N].

The PLC Type Setup dialog box appears.
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2. Select the PLC Type and Revision corresponding to the PLC to be used.

3. By default, documentation is saved with logic, data, and configuration in the same

*.FSS file. However, documentation can be shared with other applications and pro-

grams by saving it in a separate database file. Click the Advanced button to display

the Shared Address Documentation dialog box and specify the separate database

file.

NOTE: Programs cannot be saved in demo mode.

Opening a File Offline

Logic, data, configuration, and documentation can be edited in the *.FSS file without in-

volving the PLC in any way. To open an existing *.FSS file offline:

1. Click Open from the File menu, click the Open toolbar button , or press

CTRL+O. The Open Program dialog box appears.

2. Click Browse and select the *.FSS file.

3. Select the Offline option button.
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Converting a *.VP5 Program

*.VP5 is the file extension used by TISOFT files. To convert a *.VP5 program:

1. Click Open from the File menu, click the Open toolbar button , or press

CTRL+O. The Open Program dialog box appears.

2. Click Browse and select the *.VP5 program to be converted. The logic and doc-

umentation of the *.VP5 file are imported into a new offline program. The new

offline program is saved as a *.FSS file.

NOTE: Programs cannot be saved in demo mode.

Going Online

Using Fast PLC Connect

Fast PLC Connect is used to read logic, data, and configuration read from the PLC

memory. Since no .FSS file is opened in a Fast PLC connection, no documentation will be

associated with the program. Prior to connecting via Fast PLC Connect the first time, the

PLC connection needs to be set up.

To connect online to a PLC, click Fast PLC Connect from the File menu or click the

toolbar button.

Connecting Online with a Program File

Connecting online with a program file allows logic, data, and configuration to be read from

the PLC memory and associated documentation to be read from the *.FSS file.

To connect online with a PLC:

1. Click Open from the File menu, click the Open toolbar button , or press

CTRL+O. The Open Program dialog box appears.
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2. Click Browse and select the *.FSS file.

3. Select the Connect to PLC option button.

4. Click Setup and configure the PLC communication options.

To load the logic, data, and configuration from the

*.FSS file into the PLC, select the Transfer Logic

to PLC check box. Any logic, data, and con-

figuration within the PLC memory will be

overwritten.

Loading a File to the PLC

Loading a program allows logic, data, and configuration from the *.FSS file to be down-

loaded to the PLC. Associated documentation will be read from the *.FSS file.

To load an existing program into an online PLC:

1. Click Open from the File menu, click the toolbar button, or press

CTRL+O. The Open Program dialog box appears.
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2. Click Browse and select the program to be loaded into the PLC.

3. Select Connect to PLC.

4. Select the Transfer Logic to PLC check box. 

Logic, data, and configuration from the *.FSS file

will overwrite logic within the PLC memory.

Transferring an Offline Program Online

Logic, data, and configuration from a program that has been opened in offline mode can be

transferred to the PLC.

To transfer an existing open offline program to the PLC, click Transfer -> Online from

the File menu. The Open Program dialog box appears with the file path and name of the

offline program displayed in the Program File box, the Connect to PLC option selected,

and the Transfer Logic to PLC check box selected.
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Any logic, data, and configuration within the PLC

memory will be overwritten. Documentation will

also now be associated with the file being trans-

ferred.

Loading Parts of a File Online

Individual program components from the *.FSS file can be downloaded to a PLC.

To load program components into a PLC:

1. Establish an online connection with the PLC.

2. Click Load By Parts from the File menu. The Load Program by Parts dialog

box appears.
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3. Click Browse and select the program to be loaded into the PLC.

4. Select the check boxes of the program parts to be loaded, or select the Load Com-

plete Program check box to load all parts.

Program components that are loaded from the

*.FSS file will overwrite any program components

within the PLC memory. Programs cannot be

loaded by parts in demo mode.

Saving A Program from the PLC to Disk

Logic, data, and configuration from the PLC memory can be saved/uploaded to a *.FSS

file.

To save a program in the PLC to a file:
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1. While online, click Save As from the File menu, click the  toolbar button, or

press CTRL+S. The Save dialog box appears.

2. Select the check boxes of the program components to be saved.

The *.FSS file will be overwritten. Programs cannot

be saved in demo mode.

Programming Ladder

Using Edit Mode and Validate and Enter

When editing logic, the ladder is placed in Edit mode. Edit mode is indicated by a change

in background color. In Online mode, a network in Edit mode is held in a special buffer

outside the actual program, and the original network remains temporarily unchanged.

When edits have been completed, Validate and Enter the changes by clicking Validate

and Enter from the Program menu, clicking the check mark  toolbar button, or press-

ing F8. 505 WorkShop validates the changed networks, and if the networks are valid,

enters them in the actual program. If necessary, 505 WorkShop displays a dialog box so the

PLC can be stopped. In either Online or Offline mode, the network background color re-

turns to the normal display.
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The validation only examines the edited network. It

is possible for changes in one network to affect an-

other, causing unexpected results.

Inserting a New Network

To insert a new network in the active logic program window:

1. Click the  toolbar button. The new network attaches to the mouse pointer.

2. Click on the logic program in the location where the new network is to be placed.

The new network is inserted, and the pointer returns to an arrow.

Appending a New Row

To add a new row to a network in the active logic program window:

1. Click the  toolbar button. The new row attaches to the mouse pointer.

2. Click on the logic program in the location where the new row is to be placed. The

new row is inserted, and the pointer returns to an arrow.

Entering Ladder Instructions

To enter ladder instructions by selecting the appropriate instruction from the Instruction

Bar:

1. Click on the appropriate Instruction Group (for example, Relay) on the Instruction

Bar to display the instructions within that group.

2. Select an instruction by clicking it. The instruction attaches to the mouse pointer.

3. Click on the logic program in the location where the instruction is to be placed. The

instruction is inserted, and the pointer returns to an arrow. If the instruction cannot

be placed in that location, an error message is displayed.

Typing Mnemonic Instructions

Instructions can be entered using mnemonics. To enter an instruction mnemonic: 
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1. Place the cursor at a location, enter the instruction mnemonic, and press ENTER.

2. To display a list of instruction mnemonics, press ? and then press ENTER. The fol-

lowingMnemonics dialog box appears.

3. Select a mnemonic by double-clicking it or by using the arrow keys to select it and

then pressing ENTER.

TIP: The Mnemonics dialog box will also appear if an invalid mne-

monic is entered.

Obtaining Help

When working in the logic program, help text regarding specific instructions can be quickly

referenced. To display help text:

1. Click on the toolbar button. A question mark attaches to the mouse pointer.

2. Click on the desired instructionwithin the logic program. The help text related to that

instructionwill appear in a separate window, and the pointerwill return to arrow.
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For example, clicking on with the toolbar button will display the following

help text:
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Simulator Overview

505 Simulator is designed to run and test 505 ladder logic, special functions, PID loops,

Analog alarms, and simulated I/O without the use of a PLC.

Starting Simulator

Use any of the following methods to start the 505 Simulator:

l Within 505 WorkShop, click 505 Simulator from the Viewmenu.

l Within 505 WorkShop, click the Simulator button on the main toolbar.

l Start Windows, click the Start button, click All Programs, click FasTrak

SoftWorks, and then click 505 Simulator.

After starting, the 505 Simulator Window is displayed:
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Selecting PLC Type

1. In the PLC Type Selection box, select the PLC type you want to simulate.

2. Click Accept. The following warning appears:

3. Click Yes. The simulator is now simulating the PLC type you selected.
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Setting Up Communications with Simulator in 505

WorkShop

505 Simulator uses the TCP/IP communication method to communicate with 505

WorkShop. Do the following to create a new TCP/IP connection in 505 WorkShop to con-

nect to the simulator:

1. In 505 WorkShop, click Communications Setup from the File menu. The Com-

munication Setup dialog box appears.

2. Click the TCP/IP button. The TCP/IP Setup dialog box appears.
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3. Under Communication Settings, enter 1505 in the TCP Port box. The TCP Port

must be set to 1505 to enable connection with the simulator. The other com-

munication settings can be changed as needed; refer to the 505 WorkShop online

help for additional information.

4. Click Add. The TCP/IP Path dialog box appears.
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5. In the IP PAddress box, enter 127.0.0.1.

6. In the Path Description box, enter a description that identifies the 505 Simulator,

such as 505 Simulator.

7. Click OK.

Connecting to 505 Simulator

Prerequisites

In order to connect to the 505 Simulator, both 505 WorkShop and 505 Simulator must be

currently running. In addition, within 505 WorkShop, a TCP/IP communication method

that uses an IP address of 127.0.0.1 must be created.

Connecting

Once these prerequisites have been met, connecting to the simulator is identical to going

online with an actual PLC. Within 505 WorkShop, click Open from the File menu, or

click the Open button on the main toolbar.

Note:   505 Simulator must be running before attempting to con-

nect to it.
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